Table of Contents

1 Introduction ................................................. 4
   1.1 System Requirements ............................................. 6
   1.2 Installation and Licensing ........................................ 7

2 Creating a New Report .................................... 9
   2.1 Entering Data ....................................................... 14
   2.2 Entering Data into Three-Dimensional Tables (Z-Axis) ........................................ 19
   2.3 Controlling Accuracy of Cells .................................. 23

3 Common Tasks ............................................... 26
   3.1 Validating Data ..................................................... 26
   3.2 Exporting Data to XBRL .......................................... 29
   3.3 Importing Data ..................................................... 30

4 Command Reference ........................................ 32

5 License Information ......................................... 34
   5.1 Electronic Software Distribution ................................. 35
   5.2 Software Activation and License Metering ...................... 36
   5.3 Altova XBRL Add-in Software License Agreement ................ 38

Index ................................................................ 39
1 Introduction

The Altova Solvency II XBRL add-in for Excel is targeted towards businesses and organizations that submit Solvency II data in XBRL format, as part of Solvency II regulatory framework for insurance companies.

The Altova Solvency II XBRL add-in for Excel enables stakeholders in the Solvency II process to do the following:

- Enter Solvency II data in Microsoft Excel, using a predefined template spreadsheet which maps to the Solvency II XBRL taxonomy.
- Validate report data directly from Excel, to ensure it conforms to the Solvency II XBRL taxonomy.
- Export Solvency II reports from Excel to XBRL format.
- Import data from existing Solvency II XBRL reports into Excel.

The following taxonomies are currently supported:

- Solvency II Taxonomies 2.0.1, 2.1.0, 2.2.0 HOTFIX, 2.3.0 HOTFIX, 2.4.0 (with HOTFIX 04/11/2019)
- Pension Funds Taxonomy 2.3.0

In addition, the supported local taxonomies are as follows:

- Bank of England (BOE) Insurance Taxonomy 1.1
- Central Bank of Ireland (CBI) Solvency II NST 1.4
- De Nederlandse Bank Financieel Toetsingskader (DNB FTK) 2.1
- National Bank of Belgium (NBB) IRI 1.0.1

Notes:
- The additional local taxonomies are not installed by default. You can download them at https://www.altova.com/solvency/download#components.
- For older versions of supported taxonomies, clear the Show most current entry points check box on the “Select Entry Point” dialog box, see Creating a New Report.

Last updated: 26 May 2020
1.1 System Requirements

To install and run the add-in, the following system requirements apply:

- Windows 7 SP1 with Platform Update, Windows 8, Windows 10, Windows Server 2008 R2 SP1 with Platform Update or newer
- .NET Framework 4.0 or later

Also, note the following important points:

- The add-in is available for both Microsoft Excel 32-bit and 64-bit. Because of memory requirements, some entry points cannot be loaded in the 32-bit version of the add-in, in which case they are disabled. To load such entry points, use Excel 64-bit and install the 64-bit version of the add-in.
- The add-in requires full access to the Excel document in order to create, validate, and export XBRL reports. If your organization enforces Information Rights Management (IRM) using the Azure Information Protection or a similar technology, the latter may restrict access to the Excel document, and thus prevent the add-in from working. For information about how to permit code to run behind documents with restricted permissions, see https://docs.microsoft.com/en-us/visualstudio/vsto/how-to-permit-code-to-run-behind-documents-with-restricted-permissions?view=vs-2019.
1.2 Installation and Licensing

To install the Altova Solvency II XBRL add-in for Excel, download the executable from the Altova Download Center (https://www.altova.com/download) and run it. Follow the wizard steps to complete the installation. You will need to accept the license agreement and privacy policy in order to proceed with the installation.

Make sure to download the executable corresponding to your operating system's and Excel platform (32-bit or 64-bit). The 32-bit executable can be installed on both 32-bit and 64-bit Windows; however, it supports only Excel 32-bit. Note that if you have Excel 32-bit and install the 64-bit version of the add-in, you will still be running the 32-bit version.

After installation, a new tab called Solvency II becomes available in the Excel ribbon.

Licensing

To use Altova Solvency II XBRL add-in for Excel, you need a valid license key code. To purchase a new key code, or request a free evaluation from the Altova website, take the following steps:

1. In the Excel ribbon, click the Solvency II tab.
2. Click Add-In Activation.

A dialog box appears with instructions for getting a new license from Altova, or managing an existing license.

After you purchase a key code from Altova, follow the same steps as above to open the activation dialog box and enter the key code.

Alternatively, you can upload purchased licenses to an Altova LicenseServer running on your organization's network. Altova LicenseServer is a free product that helps organizations manage all Altova licenses in a centralized place. For more information about LicenseServer, see https://www.altova.com/licenseserver.

See also License Information.
How to view the current version of the add-in

1. In the Excel ribbon, click the **Solvency II** tab.
2. Click **About Solvency II Add-In**.
2 Creating a New Report

The instructions below show you how to prepare a new XBRL report based on the Solvency II XBRL taxonomy available in Altova Solvency II XBRL add-in for Excel.

To create a new report:

1. In the Excel ribbon, click the Solvency II tab.
2. Click Insert New Report.
3. When prompted, select the taxonomy entry point corresponding to the report that you wish to create.
Because of memory requirements, some entry points cannot be loaded in the 32-bit version of the add-in, in which case they appear as grayed out on the dialog box above. To make loading of such entry points possible, use Excel 64-bit and install the 64-bit version of the add-in.

4. Be patient while the report tables are loaded into Excel. During this operation, a dialog box informs you of the progress, for example:
Once the report tables have finished loading, notice the **Tables** section in the **Solvency II Report Pane**.

5. Select the check boxes next to tables that you want to include in the report. Notice that each included table appears on a new sheet in the Excel book.
You can now start entering data in tables, validate it, and export it to XBRL format. See the following topics for more information:

- Entering Data
- Controlling Accuracy of Cells
- Validating Data
- Exporting Data to XBRL

Solvency II Report Pane

**Solvency II Report Pane** is the area where you can include or exclude tables from the report, view information about each cell, and view or set various report properties. By default, this pane is visible; you can show or hide it by clicking **Toggle Solvency II Report Pane** command in the ribbon. As illustrated above, the **Solvency II Report Pane** consists of two main sections: **Properties** and **Tables**.

Properties

The properties displayed in the **Solvency II Report Pane** directly affect the content of the XBRL instance file that will be created when you export the XBRL instance. To view what each property does, click it and observe the description displayed in the gray box under the grid. Properties that are grayed out are read-only; otherwise, you can edit a property by typing text or selecting a value as applicable.

The **Scheme** and **Identifier** properties under “Reporting Entity” are typically provided by the relevant competent authorities.

Also note that, even though some property values begin with “http” (for example, **Entry Point URI**, **Scheme**), they do not necessarily point to live web resources and thus should not be considered dead links. To resolve entry point URIs, the add-in uses a catalog mechanism that maps URIs to files on the local system. This is in large part due to the size of the taxonomies and the fact that they contain thousands of files. Accessing the taxonomy files over the Internet would result in extremely slow performance, even if their issuing organizations served them that way.

Properties are grouped into the following three tabs:

- **Report** - This tab displays properties applicable to the entire report (one report corresponds to one Excel workbook).
- **Table** - This tab displays only properties of the currently selected table. A table normally corresponds to a single Excel worksheet. Therefore, whenever you click inside a new Excel sheet, the properties are re-drawn to reflect the new worksheet.
- **Cell** - This tab displays only properties of the currently selected cell. Whenever you click a new cell, the cell properties are re-drawn accordingly.

You can set the accuracy-related properties at report, table, or cell level. For more information, see **Controlling Accuracy of Cells**.

Tables

To include a table in the report at any time, select its corresponding check box in the **Solvency II Report Pane**. Each included table appears on a new sheet in the Excel book. To go to a specific sheet, either navigate to it using the standard Excel way, or click the corresponding table in the **Solvency II Report Pane**.
To remove a particular table from the report, clear the check box next to it. Tables that are not selected will not be included in the report.

Some tables support a Z-Axis (a third dimension). For information about adding a Z-Axis to a table, see Entering Data into Three-Dimensional Tables (Z-Axis).

Each report table displayed in the Solvency II Report Pane is XBRL-bound, meaning that data you enter directly in the table cells will be reflected in the XBRL instance file when the report is ready, see Exporting Data to XBRL. While the report data is work in progress, you can save the Excel workbook and reopen it at any time later, just like a standard Excel workbook.

Any sheets that contain tables are bound to the XBRL taxonomy, so they must not be deleted. It is also not recommended to rename such sheets. If necessary, you can add new sheets to the workbook; however, such sheets would not be bound to the XBRL taxonomy and consequently be ignored when you generate the XBRL instance file.
2.1 Entering Data

You can populate a report with data either by entering data into cells manually or by pasting values. With some cells, you can select a value from a predefined list (such as countries or currencies). Also, in some report tables, you may need to add new rows or columns. The following is a list of tips and best practices for entering data.

Editable versus non-editable cells

As a general rule, gray cells must not be edited. Only cells that are included in the XBRL-bound area (delimited by the table boundaries) are to be edited. For guidance with respect to the purpose of the cell, and data expected to be entered, consult the cell information (properties) displayed in the Solvency II Report Pane, in the Cell tab.

Pasting data

If you paste data from multiple columns, the number of pasted columns should correspond to the number of columns in the predefined sheet. If you accidentally paste a larger number of columns, or if you type text outside the default table, unwanted columns may appear outside the XBRL-bound area. To delete unwanted columns, right-click the cell and select Delete > Table Columns. To prevent Excel from adding new columns and rows automatically, go to File > Options > Proofing > AutoCorrect Options > AutoFormat As You Type > Apply as you work, and click to clear the Include new rows and columns in table check box.

When pasting data, it is recommended to keep only the values (and not the formatting). Namely, select the Paste Values option when pasting cells or rows.

Actual versus displayed cell value

While generating the XBRL instance file, the add-in ignores any cell formatting information and exports the actual value of the Excel cell. However, bear in mind that, as part of Excel functionality, the actual value may be different from the value displayed in the cell, because of the cell formatting information. You can view at any time the actual value (the one that will be written to the XBRL instance) in the formula bar of Excel. Consider this example:

In the example above, the value that will be written to the XBRL instance is 12345. Note that the number accuracy reported in the XBRL instance file also depends on the value you selected for the “Accuracy” properties (see Controlling Accuracy of Cells).
Enumeration values
Some cells expect a fixed predetermined value (for example, cells that represent currencies or countries). In this case, the add-in displays a small tooltip when you click the cell. You can pick up the required value from the drop-down list:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Country of authorisation</td>
<td>R0050</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Language of reporting</td>
<td>R0070</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Reporting submission date</td>
<td>R0080</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To view the full list of all possible values, click the cell and observe the cell properties in the Cell tab of the Solvency II Report Pane.

Conditional cells
In some tables, you must first fill out a cell value in order to make other cells of the table editable. For example, in the table below, the cells A5 and B5 must first be filled out before all the other cells in the same row become editable.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>F.01.01.16.01 Deposits to cedants - line-by-line reporting</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3</th>
<th>Line identification code</th>
<th>Issuer country</th>
<th>Currency</th>
<th>Total Solvency II amount</th>
<th>Accrued interest</th>
<th>Par amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>EC0010</td>
<td>EC0020</td>
<td>EC0030</td>
<td>EC0040</td>
<td>EC0050</td>
<td>EC0060</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Conditional cells can unlock cells not only from the same row, but also from the same column. For example, in the table below, cell C7 must first be filled out in order to make cells C9-C11 editable:
Cells with multiple values

Depending on the XBRL taxonomy, some reports might have facts that represent an arbitrary list of comma-separated multiple values. Consequently, in Excel, the corresponding cell also requires multiple values to be entered in the same cell. For example, the table "S.25.0.1.21.0.3" available through the entry point 21 - Annual Solvency II public disclosure Solo contains cells that take multiple values.

To enter data for such cells, first expand the drop-down list, and then click all items that qualify.
Alternatively, you can type all the numeric values, separated by a comma, as shown below. Remember that you can view all possible values of a cell in the Cell tab of the Solvency II ReportPane.

After you exit a multi-valued cell, it is automatically re-drawn to display all selected values in a readable form (even though you may have entered only numbers).

Adding new rows
With some tables, you may need to create new rows. For example, this is the case for table "S 01.03.01.01" available through the entry point Solvency II 2.3 - Annual Solvency II Reporting Solo. You can add new rows either using the standard Excel commands or shortcuts, or by clicking the Add Row button in the ribbon. For example, to add a new row to the table "C 10.02" of the entry point mentioned above, do one of the following:

- In the Excel ribbon, click the Solvency II tab, and then click Add Row | Insert Row Below. Note that the commands to insert or delete rows are enabled only if the table supports adding new rows.
- Click the rightmost cell of the last row in the table, and press Tab.
- Right-click a cell in the empty row, and select Insert | Table Row Below from the context menu.
**Note:** Any newly added rows must be within the XBRL-bound area of the table, clearly delimited by black lines.

### Adding new columns

Some tables may need extra columns to be added. In other words, they can grow horizontally. For example, this is the case for table "S.04.01.01.03" available through the entry point **Solvency II 2.3 - Annual Solvency II Reporting Solo**. You can add new columns to such tables in one of the following ways:

- In the Excel ribbon, click the **Solvency II** tab, and then click **Add Column**. Note that this command is enabled only if the table supports adding new columns according to the XBRL taxonomy.
- Click the **Add** button that appears next to the rightmost column of a table.
- Right-click a table cell, and then select **Insert | Table Columns to the Right** from the context menu.
2.2 Entering Data into Three-Dimensional Tables (Z-Axis)

Most of the report tables have only two dimensions: the x-Axis (columns) and the y-Axis (rows). However, there are some tables where you may need to enter data into a third dimension (the z-Axis). An example of such a table is the "S.16.01.01.01" table available through the entry point Solvency II 2.3 - Annual Solvency II Reporting Solo.

In cases such as the one above, you can add a new sheet along the z-Axis (third dimension) of the table, as follows:

1. In the Excel ribbon, click the Solvency II tab.
2. Click the Add New Sheet (z-Axis) button. Note that the commands to insert or delete new z-Axis sheets are enabled only if the table supports adding a z-Axis.

Alternatively, right-click the table in the Solvency II Report Pane and select Add New Sheet (z-Axis) from the context menu, for example:
This creates a new sheet that displays the third dimension of the table (z-Axis). The sheet representing the z-Axis always has an indicative name that resembles the original table. In this example, if you select "Euro" as currency, the new sheet is called "F 34.00c (EUR).

Data from the third dimension (z-Axis) of a table are displayed as new sheets in Excel. Therefore, three-dimensional tables span across more than one sheet. This is an exception to the rule that one Excel sheet corresponds to one table in the XBRL report. In the XBRL instance, data that belongs to the z-Axis will be, however, correctly reported as part of the same table.

When you click a cell that represents z-Axis, all the possible values for the drop-down list are displayed in the Cell tab of the Solvency II Report Pane, for example:
Deleting z-Axis sheets

You can delete sheets that contain data from the third dimension (z-Axis) in more than one way.

1. Select the required sheet (or click the corresponding entry in the “Tables” section of Solvency II Report Pane).
2. Do one of the following:
   - In the Solvency II tab, click Remove Sheet (z-Axis), or
   - Right-click the table in the Solvency II Report Pane and select Remove Sheet (z-Axis) from the context menu.
Creating a New Report

Entering Data into Three-Dimensional Tables (Z-Axis)
Controlling Accuracy of Cells

The accuracy of monetary and other numeric values in the XBRL report can be controlled by setting the following report properties:

1. Accuracy of monetary cells
2. Accuracy of numeric cells
3. Accuracy of percentage cells

These properties are available in the Solvency II Report Pane, in the Properties group.

---

The property **Accuracy of Monetary Cells** applies to numeric cells in the report that represent a monetary value.

The property **Accuracy of Numeric Cells** applies to numeric values that have no unit (excluding percentage values, which have their own data type).

The property **Accuracy of Percentage Cells** applies to values that represent a percentage.

To view the type of a cell, first select a cell, and then click the **Cell** tab in the Solvency II Report Pane and observe the **Type** property, for example:
The accuracy you select from the **Solvency II Report Pane** controls the accuracy that will be written for this fact in the XBRL instance file. More specifically, the "Accuracy" properties are bound to the **decimals** attribute in the XBRL instance file. For example, in the image below, the accuracy value indicated in the brackets corresponds to the value of the **decimals** attribute in the XBRL instance file.
By default, accuracy is set as follows:

- The **Accuracy of Monetary Cells** is set to **Cents (2)**, which sets the value of the `decimals` attribute in the XBRL instance to "2".
- The **Accuracy of Percentage Cells** is set to **Basis Points (4)**, which sets the value of the `decimals` attribute in the XBRL instance to "4".
- The **Accuracy of Numeric Cells** is set to **Exact (INF)**, which sets the value of the `decimals` attribute in the XBRL instance to "INF".

You can set the accuracy-related properties at report, table, or cell level (see the corresponding tabs in the image above). If you set accuracy at multiple levels, keep in mind that the more specific property always overrides the more generic one. For example, the accuracy set at cell level takes priority over the one set at table level. Likewise, the accuracy set at table level takes priority over the one set at report level.

For monetary and numeric cells, the accuracy value can be either positive or negative.

A positive value $N$ specifies the accuracy of up to $N$ digits to the right of the decimal place. For example, the value 2 specifies the accuracy to be in cents, while the value 3 specifies the accuracy to be up to mills.

A negative value $N$ specifies the accuracy of up to $N$ digits to the left of the decimal place. For example, the value -3 specifies the accuracy to be up to thousands, while the value -6 specifies the accuracy to be up to millions.
3 Common Tasks

3.1 Validating Data

Validation ensures that the XBRL data you are filing conforms to the XBRL specification. The report data should be validated before you export it to XBRL. You might also want to validate data progressively, after each action that could potentially render it invalid (for example, after pasting new rows into the spreadsheet).

To validate data, click the Validate button in the Solvency II tab of the Excel ribbon.

Be patient while Altova Solvency II XBRL add-in for Excel performs the validation process. To validate XBRL data, the add-in creates a temporary in-memory XBRL instance. When validation of the in-memory instance completes, a validation report similar to the one below is displayed.

The validation result can be any of the following:

<table>
<thead>
<tr>
<th>Message type</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td>The instance data is valid.</td>
</tr>
<tr>
<td>⚠️</td>
<td>The instance data is valid, but has inconsistencies or warnings.</td>
</tr>
<tr>
<td>✖️</td>
<td>The instance data is not valid.</td>
</tr>
</tbody>
</table>

The Validation Report dialog box may additionally display any of the following message types: information messages, warnings, and errors.
<table>
<thead>
<tr>
<th>Message type</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Denotes an information message. Information messages do not make the XBRL instance invalid.</td>
</tr>
<tr>
<td>🟠</td>
<td>Denotes a warning message, or an inconsistency. Warnings and inconsistencies do not make the XBRL instance invalid.</td>
</tr>
<tr>
<td>🟢</td>
<td>Denotes an error. If there are validation errors, the XBRL instance is not valid, and you will need to edit the report data so as to resolve each error before proceeding with the export to XBRL. Note: During validation, the add-in checks XBRL formula assertions and reports them as errors. If you are using the Altova RaptorXML+XBRL Server for validation (<a href="https://www.altova.com/raptorxml">https://www.altova.com/raptorxml</a>), XBRL formula assertions may be optionally configured not to be reported as errors.</td>
</tr>
</tbody>
</table>

When a report fails successful validation, the Validation Report window may display links to the cell where the error originates. To quickly find a cell where the error originates, click the underlined text and the cursor will be positioned automatically on the required cell. Note that there are cases where multiple cells are involved in a single validation check; in such cases, clicking on the error link will select just one of the affected cells.

To copy the contents of the validation report to clipboard:

- Click ✉️ Copy, and then paste into a target file (for example, an email). Alternatively, right-click inside the Validation Report window and select Copy All Messages from the context menu.

To save the validation report as text or HTML:

- Click 🗃️ Save. Alternatively, right-click inside the Validation Report window and select Save Validation Report from the context menu.
To clear the validation report:

- Click Clear. Alternatively, right-click inside the Validation Report window and select Clear from the context menu.
3.2 Exporting Data to XBRL

Once your report is ready and valid (see Validating Data), you can generate the XBRL instance file. To do this, click the Solvency II tab, and then click Export to XBRL.

By default, instance files are saved as files with .xbrl extension. If you need the exported file to have another extension (for example, .xml), type the file extension in the Export dialog box.

While the XBRL instance is being created, a dialog box which informs you about the progress may be displayed for a short time.

During the export operation, data is automatically validated. Any errors, inconsistencies and warnings are reported on the screen after the export finishes.

Note: Cell values that are not valid (that is, cells that don't conform to the data type of the underlying XBRL concept) prevent the report from being exported.

For tips on how to avoid data formatting errors, see Entering Data. Note, however, that not all XBRL validation errors might be related to incorrect formatting. Some errors might occur because entered data does not meet the XBRL validation rules applicable to the report you are filing.
3.3 Importing Data

You can import data from existing instances of XBRL reports into Excel (typically, files with .xbrl extension). For the import to be successful, the imported instances must be valid XBRL reports. They may be either reports you have previously generated using the Altova Solvency II XBRL add-in for Excel, or reports that you received from other parties.

To import an existing XBRL instance file into Excel:

1. In the Excel ribbon, click the Solvency II tab.
2. Click Import from XBRL, and browse for the XBRL instance file.

Note: If a report is already open in Excel, the Import from XBRL button is disabled. To enable the command, save and close the current report (workbook) and create a new workbook.

During the import operation, a dialog box informs you about the progress:

While the report data is loaded into Excel, it is automatically validated. A dialog box notifies you about potential warnings, inconsistencies, or errors (see also Validating Data).

Validation Report

Note: During import, the add-in validates XBRL formula assertions. A report will be imported even if it contains
unsatisfied assertions.
4 Command Reference

The add-in commands available in the Solvency II tab of the Excel ribbon are listed below.

Insert New Report
Creates a new Solvency II filing report, see Creating a New Report. This command is disabled if the report sheet has already been inserted into the workbook.

Import from XBRL
Imports an XBRL instance file into the current Excel spreadsheet (see Importing Data from XBRL). This command is disabled if a report has already been inserted into the workbook. To enable the command, save and close the current report (workbook), and create a new workbook.

Export to XBRL
Exports data from all currently active sheets to an XBRL instance file (see Exporting Data to XBRL).

Validate
Performs a validation of report data against the underlying XBRL taxonomy and displays the validation results in a dialog box (see Validating Data).

Toggle Solvency II Report Pane
Toggles the Solvency II Report Pane on or off. By default, this pane is visible.

Toggle Validation Report
Shows or hides the “Validation Report” window, see Validating Data.

Add Sheet (z-Axis)
Adds a new sheet which provides the ability to enter data in a third dimension. This button is enabled only if the table supports a third dimension according to XBRL taxonomy. For more information, see Entering Data into Three-Dimensional Tables (Z-Axis).

Remove Sheet (z-Axis)
Removes a previously added Z-axis sheet.

Add Row
Adds a new row to the currently selected table. This button is enabled only if the table supports growing vertically.

Delete Row
Deletes an existing row. This button is enabled only if the table supports growing vertically.
Add Column
Adds a new column to the currently selected table. This button is enabled only if the table supports growing horizontally.

Remove Column
Removes an existing column. This button is enabled only if the table supports growing horizontally.

Help
Opens this help file, in CHM (Microsoft Compiled HTML Help) format.

Add-In Activation
Displays the activation status of the add-in, or provides options to enter or purchase a license key code.

About Solvency II Add-In
Displays version information about the add-in.

Altova on the Web
Provides links to the Altova website (including Online Support Center, components download page, training and tutorials).
5  License Information

This section contains information about:

- the distribution of this software product
- software activation and license metering
- the license agreement governing the use of this product

Please read this information carefully. It is binding upon you since you agreed to these terms when you installed this software product.

To view the terms of any Altova license, go to the Altova Legal Information page at the Altova website.
5.1 **Electronic Software Distribution**

This product is available through electronic software distribution, a distribution method that provides the following unique benefits:

- You can evaluate the software free-of-charge for 30 days before making a purchasing decision. *(Note: Altova MobileTogether Designer is licensed free of charge.)*
- Once you decide to buy the software, you can place your order online at the [Altova website](https://www.altova.com) and get a fully licensed product within minutes.
- When you place an online order, you always get the latest version of our software.
- The product package includes an onscreen help system that can be accessed from within the application interface. The latest version of the user manual is available at [www.altova.com](https://www.altova.com) in (i) HTML format for online browsing, and (ii) PDF format for download (and to print if you prefer to have the documentation on paper).

### 30-day evaluation period

After downloading this product, you can evaluate it for a period of up to 30 days free of charge. About 20 days into the evaluation period, the software will start to remind you that it has not yet been licensed. The reminder message will be displayed once each time you start the application. If you would like to continue using the program after the 30-day evaluation period, you must purchase a product license, which is delivered in the form of a license file containing a key code. Unlock the product by entering this key code in the Software Activation dialog of your product.

You can purchase product licenses at the [Altova online shop](https://www.altova.com).

### Helping Others within Your Organization to Evaluate the Software

If you wish to distribute the evaluation version within your company network, or if you plan to use it on a PC that is not connected to the Internet, you may distribute only the installer file, provided that this file is not modified in any way. Any person who accesses the software installer that you have provided must request their own 30-day evaluation license key code and after expiration of their evaluation period, must also purchase a license in order to be able to continue using the product.
5.2 Software Activation and License Metering

As part of Altova’s Software Activation, the software may use your internal network and Internet connection for the purpose of transmitting license-related data at the time of installation, registration, use, or update to an Altova-operated license server and validating the authenticity of the license-related data in order to protect Altova against unlicensed or illegal use of the software and to improve customer service. Activation is based on the exchange of license related data such as operating system, IP address, date/time, software version, and computer name, along with other information between your computer and an Altova license server.

Your Altova product has a built-in license metering module that further helps you avoid any unintentional violation of the End User License Agreement. Your product is licensed either as a single-user or multi-user installation, and the license-metering module makes sure that no more than the licensed number of users use the application concurrently.

This license-metering technology uses your local area network (LAN) to communicate between instances of the application running on different computers.

Single license

When the application starts up, as part of the license metering process, the software sends a short broadcast datagram to find any other instance of the product running on another computer in the same network segment. If it doesn't get any response, it will open a port for listening to other instances of the application.

Multi-user license

If more than one instance of the application is used within the same LAN, these instances will briefly communicate with each other on startup. These instances exchange key-codes in order to help you to better determine that the number of concurrent licenses purchased is not accidentally violated. This is the same kind of license metering technology that is common in the Unix world and with a number of database development tools. It allows Altova customers to purchase reasonably-priced concurrent-use multi-user licenses.

We have also designed the applications so that they send few and small network packets so as to not put a burden on your network. The TCP/IP ports (2799) used by your Altova product are officially registered with the IANA (see the IANA Service Name Registry for details) and our license-metering module is tested and proven technology.

If you are using a firewall, you may notice communications on port 2799 between the computers that are running Altova products. You are, of course, free to block such traffic between different groups in your organization, as long as you can ensure by other means, that your license agreement is not violated.

If you are online, you will also notice that your Altova software provides many useful functions. These are unrelated to the license-metering technology.

Note about certificates

Your Altova application contacts the Altova licensing server (link.altova.com) via HTTPS. For this communication, Altova uses a registered SSL certificate. If this certificate is replaced (for example, by your IT department or an external agency), then your Altova application will warn you about the connection being insecure. You could use the replacement certificate to start your Altova application, but you would be doing this at your own risk. If you see a Non-secure connection warning message, check the origin of the certificate and
consult your IT team (who would be able to decide whether the interception and replacement of the Altova certificate should continue or not).

If your organization needs to use its own certificate (for example, to monitor communication to and from client machines), then we recommend that you install Altova's free license management software, Altova LicenseServer, on your network. Under this setup, client machines can continue to use your organization's certificates, while Altova LicenseServer can be allowed to use the Altova certificate for communication with Altova.
5.3 Altova XBRL Add-in Software License Agreement

- The Altova XBRL Add-in Software License Agreement is available here: https://www.altova.com/legal/xbrl-add-in-eula
- Altova's Privacy Policy is available here: https://www.altova.com/privacy
Index

6

64-bit Excel,
using the add-in on, 6, 7, 9

A

Altova Solvency II XBRL add-in for Excel,
about, 4
command reference, 32
installation, 7
licensing, 7
limitations, 4
system requirements, 4
viewing the current version, 7

Azure Information Protection,
and restricted access, 6

C

Copyright information, 34

D

Distribution,
of Altova’s software products, 34, 35

E

End User License Agreement, 34
Evaluation period,
of Altova’s software products, 34, 35

Excel,
exporting to XBRL instance, 29
Excel .xltx template,
adding shortcuts to, 9
opening, 9

Export,
Excel report to XBRL instance, 29

I

Import,
XBRL instance into Excel, 30

Information Rights Management,
and restricted access, 6
Installation, 7

L

Legal information, 34
License,
information about, 34

License metering,
in Altova products, 36

S

Solvency II data,
entering, 14
importing from XBRL instance, 30
pasting, 14
validating, 26
System requirements, 4

T

Tables,
adding columns, 14
adding rows, 14

V

Validation, 26

© 2020 Altova GmbH